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Superelastic Collisions with the New Vernier Dynamics
Cart and Track System with Motion Encoder

Dynamics experiments are a core part of many physics courses, and low-friction carts and tracks

have long been a popular tool for use with Vernier sensors. Based on customer feedback, we have
redesigned our carts and accessories, making a good system even better. Renamed the Dynamics Cart
and Track System, the set is available with or without our unique Motion Encoder System, and with
either a 1.2 or 2.2 meter track. Additional accessories, such as a pulley and pulley bracket, are also now
included—all for an even lower price.

The carts have been redesigned from the axles up. It is much easier to attach sensors and masses

to the carts, and, to facilitate classroom discussions, the carts now come in two colors. A new,
triggered-release mode for the spring plunger allows students to set up a superelastic collision
between two carts—a collision where the kinetic energy increases. Such a collision still conserves
momentum because the plunger spring force is internal to the two-cart system. (continued on page 2)

NEW Vernier Thermal Analysis App for the
FLIR ONE™ Camera

You have probably seen thermal images showing the relative
temperature of objects based on infrared emission. Vernier is
developing an application to quantitatively analyze thermal images
using meters and real-time graphing. Thermal Analysis, a unique
and new iOS app, allows you to connect a FLIR ONE infrared camera
to your iPhone®, iPod touch®, or iPad®, and graph temperature vs.
time data. You can then export the data to the Graphical Analysis™
app for further analysis or export a thermal image movie or photo
with a graph to the Photos app on your iOS device.

Using Thermal Analysis, you can analyze temperature vs. time data
for up to four points or regions—compare temperatures in different
beakers, at specific points along a heat conducting metal rod, or
individual turtles basking in the sun. The app is also able to graph
temperature differences between points and calculate maximum,
minimum, or mean temperature of selected regions on the graph.

Imagine dragging a block across a carpet and seeing the
temperature difference where the block was dragged. Bring alive

Mu”su:::n;}up;nmn.:: . - ; . . ) ;
Time convection in fluids. Examine animal temperatures non-invasively.

Graphing temperature vs. time for
multiple points in a thermal video.

These are just a few of the investigations that can be done with the
Thermal Analysis app.

Download the free Thermal Analysis app from the App Store. The innovative FLIR ONE camera for iOS
is available from Vernier (order code FLIRONE-IOS, $249).



Physics

Superelastic Collisions with the New Vernier Dynamics Cart and Track System with Motion Encoder

(continued from the front cover)

To demonstrate the superelastic collision feature, we started with a
standard Vernier Dynamics Cart and Track System with Motion Encoder
and Long Track, which includes one plunger cart and one encoder cart.
We used the optional Motion Encoder Upgrade Kit (DTS-MEU, $149)

to turn the plunger cart into an encoder cart. This gave us the ability to
track both carts simultaneously, providing excellent position and velocity
measurements.
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In Logger Pro, we configured the Motion Encoder so that the carts
shared the same coordinate system, with the same zero position and
positive direction. We started the experiment with the plunger cart at
rest, and rolled the plain cart into the plunger cart. On impact, the carts
explosively moved apart, with the plain cart reversing direction. The
position graph shows the motion clearly, with the cart represented by
the blue line rolling into, and then away from, the other cart. Note the
complete absence of spikes or other noise in the graph traces, made
possible by the Motion Encoder System.

The cart masses were approximately the same (see table). The total
kinetic energy of the two-cart system changed by more than a factor
of four. The total momentum was essentially unchanged, as expected,
because the spring force was internal to the system.

Plain Plunger Total  Total kinetic
cart* cart’ momentum energy
Velocity before (m/s) 0.541 0.000 — —
Momentum before 0.173 0.000 0.173 —
(kg m/s)
Kinetic energy before (J)  0.047 0.000 — 0.047
Velocity after (m/s) -0.514 1.028 — —
Momentum after -0.164 0.334 0.169 —
(kg m/s)
Kinetic energy after (J) 0.042 0.171 — 0.214

*Plain cart mass: 0.3198 kg "Plunger cart mass: 0.3245 kg

In addition to studying superelastic collisions, have students use

the Dynamics Cart and Track System to investigate various kinds of
collisions, including elastic collisions using magnets as a nearly energy
lossless bumper, lossy inelastic collisions using a spring plunger, and
totally inelastic collisions using hook-and-pile tabs.

Dynamics Cart and Track System Pricing
Dynamics Cart and Track System DTS $239

Dynamics Cart and Track System with Long Track DTS-LONG $339

Dynamics Cart and Track System with DTS-EC $384
Motion Encoder

Dynamics Cart and Track System with DTS-EC-LONG  $484

Motion Encoder and Long Track

In the Physics Journals

A Perspective on Motion Sensors and Free Fall
Derrick E. Boucher; American Journal of Physics. 2015, 83, 948-951.

Those of you who use Motion Detectors frequently, especially for
studying free-falling objects, may find this article enlightening.

It is a detailed study of how the horizontal position of the

object relative to the Motion Detector can introduce an error

in measured accelerations. The errors can make the measured
accelerations slightly high.

Workshop Physics and Related Curricula:
A 25-Year History of Collaborative Learning Enhanced
by Computer Tools for Observation and Analysis

Priscilla W. Laws; Maxine C. Willis; and David R. Sokoloff;
The Physics Teacher. 2015, 53, 401-406.

This article describes the 25-year history of development of
Workshop Physics and RealTime Physics and their influence
on physics education around the world. We are proud to have
worked with the authors for all of those 25 years.

The Atwood Machine Revisited Using Smartphones

Martin Monteiro; Cecilia Stari; Cecilia Cabeza; Arturo C. Marti;
The Physics Teacher. 2015, 53, 373-374.

A smartphone is used to enhance a classic physics experiment. The
phone is used as the weight on one side of an Atwood machine,
and it also measures the acceleration. Our Graphical Analysis app
is used to graph and analyze the data. The authors demonstrate
that you can nicely show a linear relationship between the mass
difference and vertical acceleration.

Turn Your Smartphone into a Science Laboratory

Rebecca Vieyra; Chrystian Vieyra; Philippe Jeanjacquot; Arturo
Marti; and Martin Monteiro; The Science Teacher. 2015, 82, 32-39.

This article explains how to use the accelerometers in your
smartphone to do a number of great physics experiments,
including measuring the acceleration due to gravity, studying
acceleration in an elevator, or measuring centripetal acceleration
on a turntable. The best way to analyze the data collected this
way is to use our Graphical Analysis for iOS or Android. Both apps
are free downloads.
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Physics

Demonstrating the Coefficient of
Friction Using the Vernier Force Plate

By Bill Berner, University of Pennsylvania
Department of Physics & Astronomy

Setup for coefficient of kinetic friction demonstration

The equation that characterizes kinetic friction is not hard to evaluate
with measured data. But the normal force and frictional resistance are
usually measured at two different times and only brought together
later in the equation. While this approach yields workable numbers, it
presents friction as a number rather than a process. By measuring these
two forces simultaneously and in real time, the cause and effect nature
of the friction process is hard to miss.

Kinetic friction can

3 be measured by
pulling an object at
2 a constant velocity

with a Dual-Range
Force Sensor. With

o no acceleration,

the zero-net-force
condition means

& the force applied

by pulling the force
sensor must equal the
resistance of friction.
L This has the added
benefit of revisiting
Tima () the concept of net
force. If the object is
013 pulled across a Vernier
Force Plate, the normal
§ 0es force can be recorded
simultaneously.
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i & Fl 1| The objects pulled

Tima (%) should be stackable
blocks less than half
the dimension of the
plate, and the friction
can be made more
repeatable by sticking a felt furniture slider to the bottom block. The
three-block strategy enables adding or removing masses while dragging.
This introduces changes into the graphs of both the pulling force
(friction) and the normal force. Force sensors should be zeroed with no
loads to ensure valid calculations. A little practice ahead of time will let
you get your speeds and times right.

e
ka

Simultaneous graphs of the normal force and friction
force plus a graph of the calculated coefficient of
kinetic friction

Before collecting data, insert a calculated column equal to the ratio of
the two forces; that is, the coefficient of kinetic friction. Doing this live
clarifies the relationship between the measurements and the standard
expression for kinetic friction. The graph of the calculated column is
inserted below the other two force graphs. It shows all the important
features of a “coefficient”: it remains constant while its parameters vary
(by a factor of three in this case), and the units of its parameters cancel
leaving the coefficient dimensionless.

Because space and time are limited for the block changes, it is hard to
do with any finesse. It's tough to match the motion of the added block
to the moving block, and big force spikes occur. This problem is easier
to avoid if blocks are removed rather than added. Starting with three
blocks and removing them one at a time as the stack is dragged across
the Force Plate produces cleaner data. As can be seen in the photo,
the blocks are stacked with slight overhangs to make them easier to
remove. The graph shows that some spikes are unavoidable, but the
fundamental behavior is clear. By changing surfaces, materials, and
inclines this procedure could expand to a full lab or an independent
student project.

Interested in submitting a success story
of your own?

We welcome your ideas and stories on how you're
using Vernier technology. Send your ideas to
innovativeuses@vernier.com

NSTA Recommends
Go Wireless® Link

Go Wireless Link received a positive review from Martin Horejsi,
who writes for the National Science Teachers Association blog. His
review provides a detailed account of the use of Go Wireless Link
with a Flow Rate Sensor to measure the water speed of a paddle
boarder.

“Go Wireless Link is a small but effective solution to expand the
scope and reach of over 40 sensors. Using a Bluetooth® bridge
between sensor and computer or tablet and a usable range
extending up to 30 meters, the Go Wireless Link provides an
upgrade to existing sensors and a new frontier in what's possible
in data collection.”

Read the full review at www.vernier.com/r161
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Physics

Build a Simple Timer Circuit Using the
Optional Breadboard Kit for the Vernier
Circuit Board 2

Install the Optional Breadboard Kit
(VCB2-0OBBK, $29) on the Vernier
Circuit Board 2 (VCB2, $129) and
extend your range of electronics labs.
The kit includes two transistors (one
PNP and one NPN), a 555 timer, a
three-color LED, green and blue LEDs,
a photocell, and some 220 Q resistors.
Additional wires for connecting points
on the breadboard to each other and
wires for connecting points on the
breadboard to the VCB 2 terminals are
included.

VCB2-OBBK, $29

The diagram shows a simple circuit that blinks two LEDs alternately.

You can easily build this circuit using the components on the Vernier
Circuit Board 2 and the parts included in the Optional Breadboard Kit.
The numbers next to points in the circuit correspond to terminals on the
VCB2. Components with labels R8, C1, and R10 refer to components on
the VCB2. Use 4 AA batteries or a LabQuest Power Supply (LQ-PS, $11)
to provide power to the circuit.
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Circuit diagram for two alternately blinking LEDs

You can also use the
Optional Breadboard
Kit to add your own
components. For
example, you can
provide a wider
variety of capacitors
or resistors for
additional RC circuit
options or hand a set
of diodes to students
to construct a bridge
rectifier.

Assembled circuit

Sound Levels at Football and
Soccer Games

We could not resist using our new Sound Level Sensor (SLS-BTA, $69)
at some local sporting events this past fall. The first graph shows

the sound levels measured at about halfway up the stands in Autzen
Stadium during the first half of an Oregon Ducks vs. Utah Utes
football game.
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Sound levels during the first half of the Oregon vs. Utah game on September 26,
2015

The graph below shows sound levels measured during a Portland
Timbers Major League Soccer game at Providence Park. Data were
collected in the “Timbers Army” section of the stands, which is
renowned for its loud cheering and singing. Can you answer these
questions based on the graph?

¢ When did halftime occur?

¢ Do you think the home team won the game?

Game stars Timbars shot
st o goal
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Sound levels at the Portland Timbers soccer game on October 3, 2015

“Great lesson today using @VernierST software to
show foundational concepts of collisions to start
developing a ‘model” for momentum!”

— @ChaconPhysics
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Physics

Why does that lamp flicker so?
By John Gastineau, Vernier Staff Scientist and Partner

There's a table lamp in my house that flickers annoyingly. | set out to
find out what it is doing.

The lamp has an LED bulb, as it is in a location | like to keep lit all
evening. The inexpensive fixture has a built-in dimmer switch with two

positions: full-on and low. When set to low, the light flickers noticeably.

What is the nature of the intensity variation? Is there some design
aspect of the lamp that makes it more noticeable?

Sensor-based data collection can reveal things that happen too quickly
to observe directly. | used this capability to understand the lamp
behavior. To detect the intensity variation, | used a Vernier Light Sensor
and configured a LabQuest for a 0.1 s duration and a 5000 points/s
sampling rate. The collection rate was overkill, but I'd be sure to see
details. | collected data for both lamp settings.

At full brightness, the lamp brightness changes at a 120 Hz rate. That's
too fast to see easily. But at the lower setting, every other cycle is
missing, so the lamp flickers at a visible 60 Hz. The lamp must pass
current one way in the low setting. Note that | didn’t take care to hold
the Light Sensor in the same position for the two runs, so the peak
intensity happened to be higher for the low position.
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Light intensity vs. time for an inexpensive dimmer and LED lamp. Red trace is
dimmed; blue is full intensity. Note how the period is different by a factor of two.

For a comparison, | did the same measurement with a more expensive
LED bulb with a better dimmer. That lamp has no visible flicker at any
brightness level, and indeed, the LabQuest data showed an unchanged
120 Hz variation at any brightness.
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Light intensity vs. time for a more expensive dimmer and LED lamp. Red trace is
dimmed; blue is full intensity. Note the identical periods.

Now it's clear why the inexpensive lamp flickers so much at the low
setting. In this fixture, an incandescent bulb would vary in light output
much less and thus not annoy, but the energy savings is important for
an all-night lamp.

On the Resolving Time of the Vernier
Radiation Monitor

Frequent newsletter contributor Richard Born, a professor emeritus at
Northern lllinois University, developed an experiment that extends the
common uses of Vernier sensors. Geiger tubes, such as those used in
the Vernier Radiation Monitor (VRM-BTD, $169), all have a common
behavior in that the tube is briefly insensitive to a second event that
arrives quickly after another event; that is, if two events arrive within
too short an interval, the second event is missed. The duration of this
interval is known as the resolving time.

Radiation Source to G-M Window Distance = 15 mm (Runs 1-3)
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You can see this effect by measuring count rates with two different
sources separately and then together.

In this graph, the counts per interval for the sources A and B were
both around 30,000 counts/s, but together the counts were about
54,000 counts/s. Taken together, the count rate is less because the
tube misses some counts, as they arrive too quickly.

Professor Born's experiment determines that for this particular tube, the
resolving time is a bit less than 200 ps.

For a full description of the experiment, including a reliable vendor for
the radioactive sources used and sufficient information to perform your
own resolving time measurement, see www.vernier.com/r162

0
1981 1991

25 Years Ago in The Caliper

In 1991, we celebrated our 10th anniversary as a company, and

Christine commented on how much the company had grown—
with 5 full-time employees! (We have added about 100 more
since then.) We also introduced our second book of science
projects using the Apple I, Chaos in the Laboratory. It included
projects with A/D converters, stepper motors, a smart battery
charger measuring the speed of sound, and, of course, chaos.
It was STEM before there was a term for it.
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Engineering

Build a Robot with a Green Thumb

What unique, creative, and interesting solutions do you think your
students could devise when presented with this challenge?

Your challenge is to design and build a sensor-controlled watering
system for a potted houseplant using your EV3 robotics kit. Your
device should automatically water the plant when the soil is too
dry but also stop when the soil is sufficiently wet. You will use
a Vernier Soil Moisture Sensor (SMS-BTA, $95) to monitor the
moisture level of your plant’s soil. The soil will be considered “too
dry” when the moisture level falls below 20%, and sufficiently
"wet” when the moisture level rises above 28%.

p 8

The programming and constructing of a sample solution for this
challenge are clearly outlined in the teacher’s section of our Vernier
Engineering Projects with LEGO® MINDSTORMS® Education EV3

lab book (EP-EV3, $48). In our sample solution, we attach a LEGO®
pneumatic pump to a LEGO® motor. A clear plastic water bottle is
equipped with a 2-hole stopper, and tubing attaches from the bottle to
the pump and from the bottle to the plant. We program this robot using
a MINDSTORMS® Loop block that continuously monitors the reading
from the Soil Moisture Sensor. If the reading is within the range, the
robot does nothing; but if it falls below the threshold value, the program
activates the motor to pump air into the bottle and push water out to
the plant. The program waits to allow the water to percolate and loops
back to monitor the sensor reading again.

When presenting this challenge to your students, one option is to share
some, or all, of the sample solution with them. Another option is to
have your students fully take on the challenge by allowing them to come
up with their own distinct solution. This will undoubtedly lead to some
truly imaginative, interesting, and fun ways to transport, carry, or splash
water on a thirsty plant. For students who finish early or who want to
pursue an independent project, the book also provides project extension
ideas. In one project extension, a robot monitors the amount of light
that the plant receives. If the light is too low, the robot must increase
the light or warn the plant owner.

A real-world challenge like this introduces your students to the
engineering design process. Students learn about robotics and
programming, delve deeper into scientific principles, discover how
sensors work, and learn how to solve problems as a team.

For an overview of projects to test batteries, locate hidden magnets
that represent “land mines,” track the sun with solar panels, and more,
see www.vernier.com/ep-ev3

Introducing the Truss Tester Accessory

By Tom Smith, Engineering Educational Technology Specialist

The Truss Tester Accessory !*”

(VSMT-TRUSS, $128) for

the Vernier Structures '

& Materials Tester 5

(VSMT, $999) makes

testing single trusses | 1 l \
\ |

quick and efficient.
Testing trusses can be

a great engineering
design project by itself,
or you can use it as

a building block for
designing a bridge or
another structure that is
comprised of trusses.

VSMT-TRUSS, $128

I've been reading and thinking about trusses a lot lately, but |

decided to get my nose out of the books and collect some of my

own data. | took my construction skills out of the picture as much as
possible and used the corner brackets that ship with the Truss Tester.
These are also available as a 3D printer file on our website at
www.vernier.com/vsmt-truss. These brackets really make truss
construction a breeze! | simply slid them on the bottom beam of the
truss, anchored them in place with a small brad, and cut the rafters to
length. | hot glued the rafters together at the peak, although the truss
holder tended to keep those parts together during the test. | ended up
making five different angles of simple triangular trusses, ranging from
34 to 53 degrees, all with a 21 cm base. | tested each truss, noted the
maximum force required for it to fail, and plotted this data.
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z
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My data indicate that there is an optimum angle—not too steep and not
too shallow. | also observed that most of my trusses seemed to buckle
rather than pull apart or push together. In my next redesign, | started
with a 40 degree truss angle and added some mid-rafter supports.

View activities associated with the VSMT and Truss Tester Accessory at
www.vernier.com/vsmt
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Engineering

Two Engineered Solutions to
Automated Titration

Scientists engaged in research
are also often engineers.
Consider the engineering that
went into developing your

lab equipment, such as your
force sensor and auto-titration
equipment.

Are you interested in helping
your students take on an
engineering activity such as
automating a titration? You'll
find this activity among our
Engineering Extension Activities
(see www.vernier.com/engineering/science-classrooms/extensions). The
automated titrator described in the extension activity monitors the pH
of an acidic solution as a base is added via a standard buret. A Digital
Control Unit (DCU-BTD, $61) is programmed in Logger Pro to activate

a Servo Motor that opens the valve on a buret at low pH values. Once
the acid is neutralized, it closes the buret. This feedback loop can be fine
tuned to adjust for a different target pH, among other considerations.

DCU-BTD, $61
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Configuring the DCU via the Digital Out dialog box: Line 1 closes the buret at the
target pH, Line 2 turns on an LED

Check out this project, along with other engineering
extensions for your science classrooms, at
www.vernier.com/engineering/science-classrooms/extensions

A similar, more advanced project is mentioned in the “Vernier in the
Chemistry Journals” section (see page 9). Famularo, Kholod, and
Kosenkov published an article in the Journal of Chemistry Education
in which they describe a recent project in an upper-level instrumental
analysis lab class where students created their own automated
titrator devices. The article describes how the students built their
own automated titration system using Vernier pH Sensors, Arduino
microcontrollers, and off-the-shelf solenoid valves. In the end, they
succeeded not only in building an automated titrator but also at
controlling it over the Internet!

At Vernier, we applaud efforts like this that help students understand
how our sensors and equipment work. When students look under
the hood of their laboratory instrumentation and learn what makes
something tick, they gain a better understanding of both the science
they are investigating and the tools they are using.

Winners of the Vernier $5,500
Engineering Grant

Vernier Software & Technology sponsors a contest for educators who
creatively use Vernier sensors to introduce engineering concepts or
engineering practices. The prizes for the winners include $1,000 in cash,
$3,000 in Vernier technology, and $1,500 toward expenses to attend
either the NSTA STEM conference or the ASEE conference.

Congratulations to the 2015 Winners!

Carol Hsu, an instructor and College Department Chair of Engineering
and Physics at Clark College, Vancouver, WA, has her students create
and develop the rules for an engineering design competition every
quarter. For fall 2015, students were tasked with building a bridge

out of a single material to span a specified gap and to support a given
load with a maximum deflection restriction of 3 cm. They used the
Vernier Structures & Materials Tester with Logger Pro software for the
competition. Each engineering class was given a different emphasis that
aligned with the course materials. For example, the statics class focused
on truss structure calculations. Some teams used 3D modeling software
to design and analyze their bridge structures. One team used 3D
printers to print the beams of their bridge. All students were required to
demonstrate their understanding of the engineering design process.

Linda Rost, a biology and chemistry teacher at Baker High School,
Baker, MT, wanted to integrate engineering into her science classroom,
along with all three dimensions of NGSS: Disciplinary Core Ideas, Science
and Engineering Practices, and Cross Cutting Concepts. She challenged
her students to design and test a water filter that could lower turbidity
and correct low pH and high salinity. Each group was divided into
subgroups of either scientists or engineers. The scientists tested

each filtered sample to determine the effect on the three parameters
(turbidity, pH, and salinity). The engineers used the information the
scientists provided in order to design their filter. They produced and
tested three prototypes.

Honorable mention goes to the following teachers

Mario Gomes at Rochester Institute of Technology, Rochester, NY, for
his Forced Response of a Rigid-Body Pendulum activity in his third-year
undergraduate Mechanical Engineering “Engineering Applications Lab.”

Jeremy Peterson of Northern Lakes Regional Academy, Rice Lake, W],
had students send a helium balloon into the stratosphere so they could
learn about environmental gasses and open-source hardware.

Linda Rost at Baker High School, Baker, MT, is the high school winner
and also receives honorable mention for her second entry where she
had her biology students create solar cells using extracted pigments
from plants and berries.

For details about the contest and to see videos of the winning entries,
visit www.vernier.com/grants/engineering

Interested in submitting an application of your own
g an app y

next year? Applications are due January 15, 2017.
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Chemistry

NEW Biochemistry Resources for
Vernier Technology

Our college chemistry resources continue to grow and now include
biochemistry. Our new Biochemistry section of the Vernier website
provides a list of recommended Vernier products and experiments from
various Vernier lab books applicable to a biochemistry laboratory. We
have also added new experiments written specifically for biochemistry,
available as free downloads. The lab experiments include relevant
topics and use Vernier sensors and instruments, such as the Tris-
Compatible Flat pH Sensor (FPH-BTA, $99) and the Vernier UV-VIS
Spectrophotometer (VSP-UV, $1999), to teach students important
concepts, technigues, and the appropriate use of instruments for
biochemistry experiments. Each download includes a student lab
handout, instructor information for preparing reagents, hazard
information for chemicals used, and sample data.

10

pH

0 10 20 30 40
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Acid-base titration of L-histidine

One of the new experiments uses acid-base titration to explore the
acidic and basic properties of amino acids. Amino acids contain
ionizable groups and are categorized according to their interaction with
water. The ionic form of these molecules in water depends on the pH,
so a titration of an amino acid demonstrates the effect of pH on amino
acid structure. It is also useful in determining the reactivity of amino acid
side chains.

All of these resources can be found at www.vernier.com/biochemistry

How does a Colorimeter Compare to a
Spectrophotometer?

We frequently talk with teachers who wonder if they should invest in a
spectrophotometer or if they can run an experiment successfully with
the more affordable colorimeter. Let’s compare the two devices to
clarify these options.

A spectrophotometer can be set to measure % transmittance or
absorbance over a wide range of wavelengths. For example, the
wavelength range of the SpectroVis Plus Spectrophotometer
(SVIS-PL, $399) is 380 nm to 950 nm, and the wavelength interval
is approximately 1 nm between reported values. In comparison, the

Vernier Colorimeter (COL-BTA, $115) can measure % transmittance and
absorbance at four specific wavelengths (430, 470, 565, and 635 nm)
produced by internal LEDs.

Many of the same experiments will produce valid results on either
device. For example, if you are doing an experiment based on Beer’s
law (absorbance vs. concentration), both devices will give you a direct
relationship between the absorbance value and the concentration of
the standard solutions. Subsequent determination of the concentration
of an unknown solution, based on the standards, will produce similar
results.

Copper (ll) Sulfate
1.0
g
3
2 0.5
500 700 200
Wavelength (nm)

Absorbance spectrum of copper (ll) sulfate using SpectroVis Plus

Deciding to purchase a colorimeter or a spectrophotometer depends
on the types of experiments in your curriculum. A spectrophotometer
is compatible with all the spectroscopy experiments in the Vernier
chemistry lab books. Several of those same experiments include
instructions for use with a colorimeter. Many of the AP* chemistry
lab experiments from the College Board emphasize the importance
of a spectrophotometer’s ability to measure a full absorbance or

% transmittance spectrum.

SpectroVis Plus Colorimeter
Wavelength options 380 to 950 nm 430, 470, 565,
635 nm
Absorbance vs. concentration  Yes Yes
Absorbance vs. time Yes Yes
Absorbance vs. wavelength Yes No

Connection type LabQuest interface LabQuest interface

and computer and Vernier

USB port computer interfaces
Order code SVIS-PL COL-BTA
Price $399 $115

Vernier offers a range of affordable educational spectrophotometers.
For more information, visit www.vernier.com/spectrometers
* AP and Advanced Placement Program are registered trademarks of the College

Entrance Examination Board, which was not involved in the production of and does
not endorse this product.

8 THE CALIPER | Spring 2016 e Vernier Software & Technology | www.vernier.com



Chemistry

Environmental Science

Vernier in the Chemistry Journals

Variations on the “Blue-Bottle” Demonstration
Using Food Items That Contain FD&C Blue #1

Felicia A. Staiger; Joshua P. Peterson; and Dean J. Campbell;
J. Chem. Educ. 2015, 92, 1684-1686.

Featured: LabQuest 2 and Colorimeter

Improvements to the Whoosh Bottle Rocket
Car Demonstration

Dean J. Campbell; Felicia A. Staiger; and Chaitanya N. Jujjavarapu;
J. Chem. Educ. 2015, 92, 1687-1691.

Featured: LabQuest 2, Surface Temperature Sensor,
Low-g Accelerometer, and Dual-Range Force Sensor

Studying Cooperative Ligand Binding in the
Undergraduate Biochemistry Laboratory:
Oxygen—Hemoglobin Dissociation Revisited

Megan K. M. Young and Theodore J. Gries; J. Chem. Educ. 2015,
92, 2173-2175.

Featured: Vernier Gas Pressure Sensor

Integrating Chemistry Laboratory Instrumentation
into the Industrial Internet: Building, Programming,
and Experimenting with an Automatic Titrator

Nicole Famularo; Yana Kholod; and Dmytro Kosenkov;
J. Chem. Educ, 2016, 93, 175-181.

Featured: Vernier pH Sensor

Kinetics, Reaction Orders, Rate Laws, and Their
Relation to Mechanisms: A Hands-On Introduction
for High School Students Using Portable
Spectrophotometry

Jack M. Carraher; Sarah M. Curry; and Jean-Philippe Tessonnier;
J. Chem. Educ. 2016, 93, 172-174.

Featured: LabQuest and SpectroVis Plus Spectrophotometer

Job Opening Announcement

We are looking for a high school chemistry teacher
who uses Vernier technology to join our team in
Beaverton, OR.

Application deadline is May 1, 2016.

Visit www.vernier.com/jobs for more information
and to apply.

An Amazon Adventure Using
LabQuest 2

By Phil Kahler, Tualatin Valley Academy, Hillsboro, OR

On July 7, 2015, while participating in the Educator Academy in the
Amazon Rainforest, | conducted an exciting data-collection study

at the Amazon Conservatory of Tropical Studies (ACTS) in Peru to

learn how microclimates change at each vertical layer of a tropical
rainforest. The initial idea was an ambitious one—lower a LabQuest 2,
a Stainless Steel Temperature Probe, a Relative Humidity Sensor, a PAR
(Photosynthetically Active Radiation) Sensor, and a GoPro® camera from
a walkway in the canopy 24 m above the forest floor to collect video
paired with data for simultaneous visual and graphical analysis.

The data show that the highest temperature and lowest relative
humidity values occurred at the rainforest canopy layer. As the
LabQuest 2 was lowered through the understory down to the forest
floor, the temperature decreased slightly while the relative humidity
rose. We also saw a dramatic difference in light levels between the
canopy and the understory. As the LabQuest 2 passed through the
understory, sudden decreases and increases in illumination were
observed. This was likely due to variation in the canopy cover.
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Temperature, relative humidity, PAR, and illumination measured while descending
through the layers of an Amazonian rainforest

This project allowed us to see firsthand the relationships between the
abiotic and biotic factors that make the Amazon a treasure trove of
biodiversity. Armed with photographs, personal stories, and data, | have
begun to impress upon my students the importance of preserving this
faraway place. It is one thing to read and talk about what’s going on in
a rainforest and quite another thing to see it first hand.

For more information about this study and the Educator Academy in the
Amazon Rainforest, see www.vernier.com/r164
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Environmental Science

Can Adding a Nose Cone Improve
Turbine Efficiency?

After reading about engineers at GE experimenting with nose cones
to improve wind turbine efficiency (see www.vernier.com/r169), we
decided to design and test our own nose cones on a KidWind Wind
Turbine (KW-BWX, $109). One of our engineers created two different
spherical-cap-shaped nose cones in a CAD program and printed them
on a 3D printer. The nose cones were designed to fit onto the KidWind

Wind Turbine Hub by fitting over the T-bolt and holding on with friction.

We designed a series of experiments to test the effect of the presence
and shape of a nose cone under a wide range of conditions, including
variations in wind speed, blade shape, and blade pitch:

Wind speed Blade shape Blade pitch

Three speed settings on a
Lasko, 20-inch square fan:
high, medium, and low

Two rectangular 10°, 20°, and
blades: 1 inch x 9inch  30°
and 3 inch x 6 inch

In the majority of our tests, the difference in energy generated with
and without the nose cones was non-existent, or within the uncertainty
values of the measurements. This was a disappointing, but meaningful,
finding.

However, there was one set of trials that showed a significant difference
when the nose cone was attached. At the highest wind speed, a load

of 51 Q, and the 3 inch x 6 inch blades at a 30° angle, the turbine
produced an average of 7.0 £ 0.1 mW without the nose cone and an
average of 9.16 £ 0.09 mW with the 4-inch-diameter nose cone—an
increase of about 30%.

=3 MW
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5 thin blade no cone | Power
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0
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Four representative data-collection runs with and without nose cones—the top
two traces represent the trials where we observed the biggest difference

in power generation, the bottom two traces show no significant

difference.

Right: Three-bladed wind turbine with 4-inch
spherical cap nose cone

You and your students can do a similar experiment. If you

don’t have access to a 3D printer, you can use hemispheres

of expanded polystyrene from a craft store, which is what the

GE engineers used for their early prototypes. If your students have
experience with CAD software and access to a 3D printer, they can
design their own nose cones or modify our designs, which are available
for 3D printing at www.thingiverse.com/vernier
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Investigating Solar Panel Output

The solar industry is in the midst of a rapid period of growth. According
to The Solar Foundation’s 2013 National Solar Jobs Census, employment
in the solar industry has grown by 53% since 2010. The Solar
Foundation'’s study went on to report that one in every 142 new jobs

in the United States was created by the solar industry. While solar

panel technology has a long way to go, researchers are presently
developing more energy-efficient solar cells, and the cost for new
technologies is declining. Engaging students in meaningful, hands-on
learning experiences is a step in preparing students to participate in the
opportunities available in the growing solar industry.

Experiments such as “Effect of Load on Solar Panel Output” and “Effect
of Temperature on Solar Panel Output” from our Renewable Energy
with Vernier lab book (REV, $48) introduce students to how load and
temperature affect the power output of solar panels. The “Variables
Affecting Solar Panel Output” experiment from the same book
challenges students to design an experiment to test a variable of their
choosing. Using the new Solar Energy Exploration Kit (KW-SEEK, $50),
with its hinged box and hook-and-pile fasteners that hold multiple solar
panels in place, students can easily develop and carry out an experiment
to discover how the angle of photovoltaic panels relative to the sun
affects power output.
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The effect of angle on the power output from three KidWind 2V Solar Panels

Download “Variables Affecting Solar Panel Output” at
www.vernier.com/r165

Science Humor

A chemist goes into a pharmacy.
Chemist: Hey, do you have any of that
isobutylphenylpropanoic acid?
Shopkeeper: You mean Advil?
Chemist: Yeah, that's it. | can never
remember that name.

Q: What is the volume of a cylinder
of radius z with a height of a?
A: Volume=pizza

| have a new theory on inertia,
but it doesn’t seem to be gaining
momentum.



Biology

Use a CO, Gas Sensor to Study
Artificial Selection in Yeast

Yeast are very important microorganisms that have been used by human
cultures for centuries. Over time, humans have had a hand in yeast
evolution through artificial selection while developing different strains
of yeast for a range of functions, including baking and brewing. You
can use our CO, Gas Sensor (CO2-BTA, $259) to perform the “Evolution
of Yeast” activity in Investigating Biology through Inquiry (BIO-I, $48)
as a simple way to demonstrate the result of evolution due to artificial
selection. Flinn Scientific, Inc. has made it even easier to conduct this
investigation by offering a guided inquiry kit, “The Evolution of Yeast
with a CO, Gas Sensor” (Flinn Catalog No. FB2128). The kit, which
contains enough materials for 30 students in an inquiry setting, includes
three strains of yeast and four different sugars, enabling students to
study how different yeast strains process various types of sugar. Aligned
to NGSS, this kit, along with Vernier technology, will help engage your
students in scientific exploration.

Ecology/Environmental Science
Teaching Award Winner Announced

Kelly Mandy of Marist School in
Atlanta, Georgia, was the 2015
recipient of the NABT Ecology/
Environmental Science Teaching Award.
This award, sponsored by Vernier,

was presented at the 2015 NABT
Professional Development Conference
in Providence, RI. Mrs. Mandy is a
seventh grade science, environmental
science, and ninth grade biology
teacher who uses the outdoors as an
extension of her classroom. Each week, her students perform water
quality tests in nearby Nancy Creek and submit results to Georgia
Adopt-a-Stream, making the students directly involved in the monitoring
of Georgia's waterways. Mrs. Mandy'’s students also design projects
based on the work completed by her previous classes, which allows
students to contribute in a short period of time to large-scale projects
like the clearing of invasive Chinese Privet from Nancy Creek.

The NABT Ecology/Environmental Science Teaching Award is given

to a secondary school teacher who has successfully developed and
demonstrated an innovative approach in the teaching of ecology/
environmental science and has carried his/her commitment to the
environment into the community. Our sponsorship of this award
includes $500 toward travel to the NABT Conference and $1,000 of
Vernier equipment. The recipient also receives a recognition plaque
and one year of complimentary membership to NABT. The application
deadline for the Ecology/Environmental Science Teaching Award is
March 15 of each year. While it has just passed for 2016, start thinking
about applying in 2017. Applications will be available after the NABT
Conference in November. You can find more information about this
award at www.nabt.org
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Respiration rate of different yeast strains fed different types of sugar

For more information about this investigation or our /nvestigating
Biology through Inquiry lab book, visit www.vernier.com/bio-i

NEW ProScope 5MP
Microscope Camera

BD-PS-MC5UW, $299*

* Microscope, iPhone, and Android device not included

Why buy brand new microscopes when you can simply update

your current microscopes with innovative imaging technology? Our
newest camera, the ProScope 5MP Microscope Camera, conveniently
replaces the eyepiece of your microscope and connects to iOS and
Android devices via Wi-Fi or directly to a computer or Chromebook

via USB. Once connected, a live image of the current view through

the microscope will be displayed. Capture still images and record

short videos using a free app on mobile devices and Chromebooks or
Logger Pro on a computer. Included with the ProScope 5MP Microscope
Camera is a mount for a mobile device, two eyepiece adapters to ensure
it fits into your microscope, a USB cable, and a power adapter. With a
fast response time and high resolution, it produces very clear images
that are easy to display, save, and incorporate directly into lab reports.
For more information, visit www.vernier.com/bd-ps-mc5uw
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Software

Logger Pro Power User Features

Are you looking for ways to expand your use of Logger Pro? Here
are tips to get you started with some of the advanced features of our
powerful data-collection and analysis software:

1 Add multiple pages within a single Logger Pro file to organize
graphs, data tables, pictures, and other information. All pages
share the same underlying data and data-collection settings. See
the Page menu for options.

p Combine data from several files into one by choosing Import from
» Logger Pro File from the File menu. You can use this feature to
easily compare data from multiple groups.

3 Choose Strike Through Data Cells from the Edit menu to
temporarily ignore some data points. This is a great way to remove
selected data from graphs or curve fits without actually deleting
the values. The values are shown with a line through them in the
data table. The feature can be used to ignore preliminary motion
detector data, for example.

4 When the graph is selected, you can use the spacebar to start or
stop data collection. No more hunting for the Collect button.

5 Draw predictions before doing experiments. To do this, choose
Draw Prediction from the Analyze menu.

6 Add a second vertical axis to display data of incommensurate units
on the same graph. For example, graph pH and the derivative of pH
on a single graph. Choose Graph Options from the Options menu
to enable and configure a second y-axis.

7 Choose Model from the Analyze menu to plot functions on a
graph; then, adjust the parameters in the function helper object by
selecting the parameter and using the arrow keys or by selecting
the value of the parameter and entering values by typing on the
keyboard or using cursor keys. Use this feature to have students find
their own best-fit line and then compare it to the least-squares fit.

8 Use calculated columns to display inferred quantities, even
during data collection. For example, graph kinetic energy using a
calculated column of 1/2 mv2 from the Motion Detector velocity
data. Use a user parameter for m while you're at it, and then add a
parameter control for m using the Insert menu.

9 Show error bars on a graph; error bars can be a fixed fraction,
fixed value, or independently entered values. Enable error bars by
choosing Column Options from the Data menu.

Create a semi-log or log-log graph by choosing Graph Options
from the Options menu.

Animated Displays in Logger Pro

One of the great, hidden features of Logger Pro is the ability to add
vector displays to motion you are studying. Two sample files that use
this feature are included with Logger Pro. One of the files, “Basketball
Shot vector analysis,” can be found in the “Sample Movies” folder.

If you open the file and play the movie, the vectors appear on the movie
as the ball moves.

Velocity vectors in Logger Pro

For a tutorial on how to set up animated displays in your Logger Pro
files, choose Open from the File menu and navigate to the “Exploring
Animated Displays” file in Sample Data > Physics > Animated Display
Vectors.

Software Updates

We regularly release software updates to add new features,
support new sensors and operating systems, and to fix the
occasional bug. Keeping up to date with software releases is
one way to keep things running smoothly in your classroom
or lab. Have you updated your Vernier applications in the last
few months? We've updated nearly all our titles since the last
newsletter—some several times.

Download updates for computer and LabQuest software
directly from our website and find links to the appropriate app
stores for updates to Chrome, i0OS, and Android applications:
www.vernier.com/downloads

Note that with an account on the Vernier website and a purchase
history of Logger Pro, you can download the Logger Pro full
installer at any time—you don’t have to wait for a CD or
download link. Give the installer to your students to install on
their home computers or provide it to your IT department.
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Spotlight on Past Vernier Award Winners

Ann Shioji
2015 Vernier/NSTA Technology Award Winner

Ann Shioji, a chemistry teacher
at Overfelt High School in San
Jose, CA, is passionate about
using technology to teach her
students how chemicals affect
their daily lives. As a 2015
Vernier/NSTA Technology Award
winner, Shioji uses SpectroVis
Plus Spectrophotometers to help
students conduct research for
her “Beauty and the Yeast” unit.
She said implementation of the
lesson would not be possible
without Vernier technology.

Students at Overfelt High School
investigate the effect of several chemicals
on yeast growth

“Yeast is a single-celled
organism, and while it can be
counted using serial dilutions
and microscopes, these methods are not as reliable as the in-situ
experiments that the use of a SpectroVis Plus allows,” Shioji said.

“The greatest impact was that students did not become inundated with
procedures, but rather they were able to apply an experimental design
efficiently.”

The SpectroVis Plus speeds up the data-collection process, allowing
students to complete a lab that usually takes two days, in a matter of
minutes. At the beginning of the lesson, students conduct preliminary
research on the gestation period and respiration rates of yeast and
perform a class investigation. They then design their own inquiry-based
experiments using SpectroVis Plus to measure how an independent
variable of their choosing affects yeast growth.

The students were eager to enter upcoming science fair competitions
and conduct multiple trials to determine the effect of several chemicals
on yeast growth. For their efforts, they were recognized as the “School
with the Best Science Fair Projects” at their district science fair.

To learn more about Ann Shioji's use of Vernier products, visit
www.vernier.com/r166

Larry Beall
Vernier 30th Anniversary Grant Winner

Larry Beall, a science teacher at
Central Campus High School in

Des Moines, IA and the director of
the high school’s lowa Energy &
Sustainability Academy (IESA), is a
true believer in hands-on learning.
“My philosophy, as well as the
philosophy of IESA, is that science

is all about seeing and doing,” said
Beall. “You can't just talk to students
about various principles and concepts;
you have to truly immerse them in the
scientific discovery process.”

e, T
A student at Central Campus
uses Vernier technology to test
water quality

IESA is a two-year program in which students receive both high school
and college credit by participating in unique field experiences and

Ashley Webb

2014 Vernier/NSTA Technology
Award Winner

Ashley Webb, a 2014 Vernier/NSTA
Technology Award winner, engages
her physics and chemistry students
at DeSoto Central High School

in Southhaven, MS in hands-on
learning as much as possible.
“Using the technology acquired
through the award, my students
have the opportunity to transform
ambiguous concepts into tangible ideas through hands-on data
collection,” said Webb. “The technology supports guided inquiry and
works masterfully for my visual and kinesthetic learners.”

Students at DeSoto Central High
School launch a water-propelled
rocket

The Vernier technology—including various sensors, LabQuests, and
the Graphical Analysis and Video Physics apps—is used, in part, during
the high school’s “Creating Leaders in STEM" program, which provides
innovative opportunities for AP Physics and AP Environmental Science
students to review for their AP tests while helping younger students
engage in STEM education.

During the program, the high school physics students conduct
inquiry-based investigations using Vernier technology to introduce

6th grade students at the school’s feeder school to Newton's three
laws of motion. The high school students then assist the groups as they
participate in an engineering design challenge, which involves building
and launching a water-propelled rocket.

“Students use the Vernier sensors and apps to collect data to describe
the mechanics of their rocket—from Newton’s third law to the
Impulse-Momentum Theorem to the idea of conservation of mechanical
energy,” said Webb.

As a result of the program, Webb's high school students strengthen
their conceptual understanding of physics while helping to spark an
interest in STEM education for the younger students.

To learn more about Ashley Webb's projects, visit
www.vernier.com/r167

in-depth studies of various energy and sustainability topics. Such field
activities include testing water, air, and soil samples at the Des Moines
River, tours of the nearby water treatment facility, and much more.

As a winner of the Vernier 30th Anniversary Grant, Beall has been able
to use data-collection technology to further support IESA students’
hands-on investigations both in the classroom and in the field. In one
such investigation, students use LabQuest, as well as a variety of Vernier
sensors—including the Dissolved Oxygen Probe, Turbidity Sensor,

pH Sensor, Stainless Steel Temperature Probe, and more—to study the
hydrologic cycle and test how farming, lawn care, and other issues
contribute to water quality.

“After conducting preliminary research, students collect and analyze
water samples from the river, draw conclusions, and then present their
findings,” said Beall. “The Vernier technology is instrumental in these
investigations—it is not only easy to use, but extremely durable, which
has been a key factor for us.”

To learn more, visit www.vernier.com/r168
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Award Winners

Vernier/NSTA Technology Award
Winners 2016

Elementary School

Sherie Ryan-Bailey
Oakley Elementary School,
Asheville, NC

Using Vernier probes, a weather station,

and resources from a local university, Sherie
Ryan-Bailey’s fifth grade students learn weather
patterns and how different factors influence
weather conditions in their area. As part of the activity, students study
micro-climates in their schoolyard, exploring which locations are the
wettest, hottest, or coolest. They then analyze the data on their own
devices through the school’s 1:1 initiative.

Middle School

Greer Harvell
Walton Middle School,
Defuniak Springs, FL

Greer Harvell's seventh grade students will use
Vernier's probeware to act as “citizen scientists”
and monitor the water quality of a lake located
less than a block from their middle school. Harvell
says Lake Defuniak is a focal point of the rural community, but it is

not monitored by local organizations. Students will measure dissolved
oxygen, pH, total dissolved solids, and temperature at different depths.

Aaron Mueller
Scullen Middle School, Naperville, IL

Aaron Mueller, a middle school science teacher

in suburban Chicago, believes all students should
examine the implications of modern development
in their communities. Aaron’s cross-grade level
collaborative project encourages students to use
Vernier probeware to explore the causes of non-point source pollution
in retention ponds and natural waterways near their school.

High School

Richard Erickson
Bayfield High School, Bayfield, WI

Richard Erickson and his students spend the
school year investigating the seiches in Lake
Superior, a standing wave oscillation created by
atmospheric forces. When a weather event is
imminent, the high schoolers—equipped with
Vernier Motion Detectors—examine the lake’s water level, then mount
detectors to the deck of a nearby boathouse. The detectors record
changes in the lake’s water level for the next seven days, and students
analyze the subsequent data to formulate mathematical models of
seiche behavior.

Dan Starr
Green Lake School, Green Lake, WI

Students at Green Lake School in Wisconsin plan
to expand their studies of the natural inland

lake near their school, which is suffering from
poor water quality. Led by instructor Dan Starr,
the students will use Vernier data-collection
technology to study the Big Green Lake’s water resources, and determine
which management decisions are necessary to improve the watershed.

Ben Smith
Peninsula High School, Rolling Hills, CA

Ben Smith believes there are still too many
questions about the role ants and termites play
in our ecosystem. His project at Peninsula High
School in Rolling Hills, CA encourages students
to launch inquiry-based field and laboratory
investigations that explore the relevance of these insects to fundamental
ecological issues. Students study spatial and temporal patterns,
biogeography, microclimate, and species diversity as part of the school’s
environmental program.

College

Kasey Wagoner
Philadelphia University,
Philadelphia, PA

Kasey Wagoner, a physics professor at
Philadelphia University, wants to improve
attitudes toward physics. He's creating a
project-based physics course for non-science
majors that will incorporate Vernier probes and software. To support
autonomy, Wagoner says students will have the freedom to develop
their own projects related to three traditional physics subject areas:
forces and motion, energy and momentum, and waves and oscillations.

Vernier Named Finalist for
Global Award

>\ GESS
/

EDUCATION

AWARDS

\ FINALIST
2016

The Global Educational Supplies & Solutions (GESS) named
Vernier Software & Technology as a finalist for Best Multi-National
Company of the Year. The association also honored Graphical
Analysis for i0S, Android, and Chrome as a finalist for Best Free
App /ICT Product.

This award reflects our commitment to providing educators in
over 130 countries with innovative products and extraordinary
educator support.
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Hands-On Summer Institutes

Most schools may close for the summer, but the learning never stops at
Vernier. Join us for a full-day exploration of Vernier’'s award-winning line
of computer and handheld data-acquisition technology. You'll leave the

workshop ready to enhance your students’ learning with data collection.

The cost of the institute is $99, which includes a lab book of your choice
(a $48 value). Please see the website for Training Package pricing. The
registration form can be found at www.vernier.com/summer-institutes

AZ Phoenix 6/20 NY Long Island 7/13
CcT Hartford 7/11 OR Beaverton 8/3
GA Atlanta 6/13 TN Nashville 6/17
1A Des Moines 6/30 X El Paso 6/23

KY Lexington 6/15 WA Seattle 8/5

MD Baltimore 7/15 Wi Milwaukee 6/27

One-Day, Subject-Specific Institutes
Held in Beaverton, OR, at the Vernier Office

Engineering for Science Classrooms Institute

For intermediate users who have some experience using Logger Pro
June 29, 2016

The $99 registration fee includes lunch and a Vernier Digital Control
Unit, a $61 value.

Vernier Sensors with Arduino™ Institute

For intermediate users
June 30, 2016

The $99 registration fee includes lunch, a SparkFun Arduino RedBoard,
and a Vernier Interface Shield, a $50 value.

Vernier Wins Stellar Service Award

Professional Development

Two-Day, Subject-Specific Institutes
Held in Beaverton, OR, at the Vernier Office

Biology Institute
July 22-23, 2016

The $199 registration fee includes lunch and a copy of the lab book,
Investigating Biology through Inquiry, a $48 value.

Chemistry Institute
July 18-19, 2016

The $199 registration fee includes lunch and a copy of a Vernier
chemistry lab book of your choice, a $48 value.

Environmental Science Institute
July 20-21, 2016

The $199 registration fee includes lunch and a copy of the lab book,
Investigating Environmental Science through Inquiry, a $48 value.

Physics Institute
June 27-28, 2016

The $199 registration fee includes lunch and a copy of the lab book,
Physics with Vernier, 3rd edition, a $48 value.

You may also be able to earn graduate education credit
through Portland State University.

Details and registration for all workshops can be found
R at www.vernier.com/training

Vernier was awarded a Stellar Service Award for Best Help Site Portal by readers of Tech & Learning, the premier

WINNER publication for education technology leaders.

TECH{LEARNING

STELLAR
SERVICE
AWARDS

=l

webinars for schools and districts.

The portal, Vernier’s Technical Information Library (TIL), houses an extensive library of technical information,
troubleshooting advice, answers to questions frequently asked by teachers, and more than 1,000 searchable technology
tips. The Vernier TIL is part of a collection of comprehensive resources that Vernier provides, which include step-by-step
tutorials, a purchasing guide, Tech Tips videos produced by Vernier product developers, and free personalized training

The TIL is just one of many ways Vernier provides uniquely remarkable customer service. The company offers free hands-on training across the
country, which allows educators to learn about probeware in a way that is fun and engaging. In addition, when you call Vernier for technical
support, you will always speak to a live person. Most times, in fact, you will speak with the person who developed the product or with a fellow

educator who has experience teaching with probeware in the classroom.
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Vernier Software & Technology ADDRESS
13979 SW Millikan Way SERVICE

H Beaverton, OR 97005-2886 REQUESTED
Vernier

888-VERNIER (888-837-6437)
fax 503-277-2440

www.vernier.com
info@vernier.com

LabQuest Stream™
Mobile-friendly technology that expands possibilities

Coming in
Spring 2016

LabQuest Stream joins the LabQuest family to bring wireless and wired connectivity to the
mobile learning environment. With LabQuest Stream, our wireless and USB sensor interface,
students have the freedom and flexibility to collect simultaneous data from multiple sensors

using a mobile device, a Chromebook™, or a computer.

Find out more at www.vernier.com/Ig-stream
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